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پودمان پنجم: تفسیر نقشه های الکتریکی به کمک رایانه

پودمان 5

تفسیر نقشه های الکتریکی به کمک رایانه

در دنیای صنعتی امروز و در کشورهای صنعتی رو به رشد که در زمینه‌های مختلف الکتریکی فعالیت 
بالایی  اهمیت  از  و...،  الکتریکی  تابلوهای  قطعات صنعتی،  برای ساخت  »نقشه«  از  استفاده  می کنند 
برخوردار است. نقشه کشی در واقع برگرفته از ایدۀ اشخاص و بر اساس تئوری‌های منطقی برق و الفبای 
آنها شکل می گیرد و ترکیبی از ترسیمات تصویرسازی دو بعدی و سه بعدی و درحقیقت زبان بین 

طراح و سازنده است.
در این پودمان به معرفی نرم افزار »ePLAN electric P8« که تخصصی ترین و جامع ترین نرم افزار در 

حوزۀ نقشه کشی برق صنعتی است، می پردازیم و با نحوۀ کار با این نرم‌افزار آشنا خواهیم شد.
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واحد یادگیری 5

شایستگی ترسیم  انواع مدارهای های قدرت،  فرمان و کنترل توسط  نرم  افزار 
»ePLAN P8«

هدف های این شایستگی عبارت اند از:
 توانایی کار کردن با نرم افزار »ePlan P8« و ساخت یک پروژه در محیط این نرم افزار

 آشنایی با کتابخانه های نرم افزار به منظور استفاده از سمبل های فراگرفته شده
 توانایی رسم انواع مدار های قدرت در نرم افزار
 توانایی رسم انواع مدار های فرمان در نرم افزار

 توانایی وارد کردن انواع »PLC« در نرم افزار »ePlan P8« و نمایش ورودی ها و خروجی های مربوط به آن
 توانایی استفاده از قابلیت آدرس دهی هوشمند نرم افزار به منظور سهولت در نقشه کشی

 توانایی تهیۀ گزارش از اطلاعات ثبت شدۀ مربوط به پروژۀ طراحی شده در نرم افزار

استاندارد عملکرد
را  کنترلی  و  فرمان  قدرت،  مدارهای های  انواع  ترسیم  توانایی  هنرجویان  یادگیری  واحد  این  اتمام  از  پس 

خواهند داشت و همچنین قادر خواهند بود گزارش‌های مورد نیاز را توسط نرم‌افزار تهیه کنند.
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معرفی نرم افزار

 »ePLAN P8« طریقۀ نصب نرم افزار

فیلم

فیلم

کاربرد نرم‌افزارهای طرّاحی 
در بیشتر شرکت‌های مهندسی و کارخانه‌های تابلوسازی جهت سهولت در تهیۀ نقشه‌های برق از این نرم‌افزارها 

استفاده می شود.

پژوهش
در خصوص مراحل پیشرفت اصول نقشه کشی در گذر زمان تحقیق کنید.

سیستم های  نقشه های  کشیدن  و  طرّاحی  جهت  حرفه ای  و  کامل  برنامه ای   »ePLAN P8« نرم افزار 
کنترلی، ابزار دقیق، برق، اتوماسیون صنعتی و پنوماتیکی است. این نرم افزار با داشتن قابلیت های خودکار، 
نقشه، شماره گذاری سیم ها،  ترسیمات شماتیک، خروجی های خودکار، صفحه بندی  )شامل  کامل  نقشه ای 
نرم افزارهایی  از  یکی   »ePLAN P8« لذا می دهد.  ارائه  ما  به  نقشه(  و خروجی های  ورودی  شماره گذاری 
ببیند. آموزش  آن  با  نقشه  و کشیدن  مورد چگونگی خواندن  باید در  الکترونیک  و  برق  فراگیران  است که 

چهار نرم‌افزار دیگر در زمینه طرّاحی انواع مدارهای برق را نام ببرید.
فعا   لیت

اکثر برندهای معتبر دنیا به سبب فراگیر شدن کاربری نرم‌افزارهای طرّاحی مجبور شده اند بلوک‌های 
تجهیزات تولیدی خود را، که با این نرم افزار‌ها سازگارند، ارائه دهند.

استفاده از نرم‌افزار‌های هوشمندِ طرّاحیِ تابلوی برق، ضریب اشتباه و زمان طرّاحی تابلو را تا میزان قابل 
توجّهی کاهش می دهد.

بدانید

بدانید
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پس از نصب نرم افزار، آیکون به شکل        بر روی صفحه ظاهر می شود. با باز کردن آن محیط کار نرم افزار، 
مطابق شکل زیر، باز می شود.

انجام دادن تنظیمات اولیه
)Back Ground Color( تنظیم رنگ پس زمینۀ محیط کار 

ابتدا با زدن بر روی آیکون تنظیمات           به محیط تنظیمات   وارد می شویم و پس از آن، مراحل بعد را 
طی می کنیم و در نهایت با انتخاب یکی ار سه حالت زیر، رنگ پس زمینۀ محیط کاری را تنظیم خواهیم کرد:

 BLACK: محیط کار مشکی؛
 GRAY: محیط کار طوسی؛
 WHITE: محیط کار سفید.

مطابق فیلم نمایش داده شده، نرم افزار »ePLAN P8« را بر روی رایانه خود نصب کنید و به سؤالات 
زیر پاسخ دهید:

 در زمان نصب نرم افزار با چه مشکلاتی مواجه شدید؟
 مشکلات به وجود آمده را چگونه مرتفع کردید؟

فعا   لیت
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 تنظیم فونت نرم افزار
مطابق شکل زیر، ابتدا با زدن بر روی آیکون تنظیمات            به محیط تنظیمات وارد می شویم و پس از 

طی مسیر زیر ده عدد فونت، که هر کدام به صورت جداگانه قابل تنظیم اند، مشاهده می شود.
Company → Graphical editing → Fonts 	

انتخاب رنگ پس زمینۀ محیط کار از چه جهت می‌تواند مهم باشد؟
بحث

ده نوع فونت متفاوت را برای فونت‌های 1 تا 10 انتخاب کنید.
فعا   لیت

پژوهش
دلیل وجود و مزیت ده عدد فونت قابل انتخاب در نرم افزار »ePLAN« چیست؟
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آشنایی با منوها در نرم افزار
الف( معرفی نوار ابزار

توضیحاتنام
Project.برای ایجاد پروژۀ جدید، بازکردن پروژه‌های قبلی و بستن پروژه‌های جاری استفاده خواهد شد
»Page«.برای ایجاد صفحات جدید، رفتن به صفحات قبلی و بعدی و شماره گذاری آنها استفاده می شود

Layout space.برای طرّاحی سه بعدی تابلو استفاده خواهد شد
Edit.از این منو برای اصلاح پروژه استفاده خواهد شد
View.از این منو برای مشاهده ابزارهایی نظیر زوم کردن و ایجاد نقاط مختصات و... استفاده خواهد شد
Insert.از این منو برای وارد کردن سمبُل، تجهیزات، متن، تصاویر و ابزار اندازه زن و... استفاده می شود

Project Data.از این منو به منظور مشاهده و اصلاح اطلاعات پایه‌ای پروژه استفاده خواهد شد
Find.برای پیدا کردن تجهیزات مختلف در محیط پروژه استفاده خواهد شد

Options.از این منو برای تنظیمات نرم‌افزار استفاده می شود

Utilities برای گرفتن گزارش، اضافه کردن تجهیزات جدید و بلوک‌های برندهای مختلف استفاده خواهد
شد.

Window.از این منو برای جابه جا شدن بین پروژه‌های مختلف استفاده خواهد شد
)Toolbar( معرفی ابزارهای کاربردی )ب

توضیحاتشکلنام

«New» Projectابزاری است جهت تعریف پروژۀ جدید

Open Project.ابزاری است جهت باز کردن پروژه‌هایی که قبلاً تعریف شده اند

Close Project.ابزاری است جهت بستن پروژه‌هایی که باز هستند

Zoom ابزاری است جهت دور یا نزدیک کردن محیط کار در صفحۀ
نمایش.

صفحۀ گرید مختصات  نقاط  دادن  نشان  جهت  است  ابزاری 
نمایش.

Page Setting ایجاد صفحات جدید و جا به جایی به منظور  ابزار  این  از 
بین صفحات مختلف استفاده می شود.

Graphic Tools.از این ابزار برای کارهای گرافیکی استفاده می شود
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»ePLAN« ایجاد یک پروژۀ جدید در
آیکون  روی  بر  کلیک  یا   »New« انتخاب  با   »Project« منوی  طریق  ایجاد از  پروژۀ جدید  یک 

می کنیم.

تفاوت گرید A ،B ،C ،D ،E را با استفاده از ابزار اندازه گیری مشخص نمایید.
فعا   لیت

نحوۀ انجام تنظیمات اولیه
فیلم

با کلیک بر روی »New« پنجره مقابل ظاهر می شود. همان طور که در شکل مشخص است، نام پروژه و محل 
ذخیره سازی آن در این پروژه تعیین می شود. پس از کامل کردن مشخصات مذکور با زدن OK، یک پنجره دیگر 
باز خواهد شد که مربوط به تنظیمات پیش فرض نرم‌افزار در خصوص پروژۀ تعریف شده است. با زدن OK به 

مرحلۀ بعد وارد می شویم.

مراحل ایجاد یک پروژه و نوشتن برنامه
فیلم
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ایجاد صفحۀ جدید در پروژه
برای ایجاد صفحۀ جدید از منوی »Page« گزینه »New« را انتخاب و مراحل زیر را متناسب با نیاز طرّاحی 

تنظیم می کنیم.

1
در صورتی که تابلو دارای چند سلول باشد از 
این پنجره جهت نام گذاری تابلو و سلول‌های 

آن استفاده می شود.

انتخاب تک یا چند خطی بودن نقشه 2

توضیحات مربوط به نقشه در این قسمت یادداشت 3
می شود.

انتخاب کادر نقشه 4

پژوهش
کاربرد »Template« در پنجرۀ روبه رو چیست؟

تفاوت بین نقشه‌های تک خطّی و چندخطّی در چیست؟

سایر گزینه‌های مربوط به »Page Type« را در تنظیمات صفحۀ جدید، بررسی کنید.

............................................Page Type............................................Symbol

............................................Multi Line............................................Plot Frame

............................................Panel............................................Grid

............................................Page Description............................................Control Circuit

............................................Single Line............................................Power Circuit

............................................Connection............................................Insert

فعا   لیت

فعا   لیت

ترجمه
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پژوهش
تحقیق کنید تفاوت بین »Symbol« و »Device« چیست؟

شروع نقشه کشی
 »Symbol« یکی از گزینه‌های ،»Insert« برای وارد کردن علائم و سمبُل‌ها و تجهیزات، ضمن ورود به منوی

یا »Device« را انتخاب و تجهیز مورد نظر را وارد خواهیم کرد.

الف( وارد کردن نقاط اتصال پتانسیلی
محیط  از  و  می‌شوند  استفاده  نقشه  به  پتانسیل  ورود  به منظور   ،»ePLAN« در  پتانسيلي  ورودي‌هاي  از 
»Toolbar« یا از منوی »Insert → Potential Connection Point« در نقشه ایجاد می‌شوند. با انتخاب 
این گزینه، سمبُل مربوطه، زیرِ نشانگرِ موس قرار خواهد گرفت. پس از انتقال سمبُل به مکان مورد نظر، با 
کلیک کردن آن در صفحه قرار می گیرد و پنجرۀ زیر، جهت تنظیمات )انتخاب نام نقطه پتانسیلی و نوع آن 
نظیر فاز، نول، ارت و...( باز خواهد شد. این عمل می تواند تا زدن کلید »ESC« به تعداد مورد نیاز ادامه یابد.

ب( چرخش الِمان‌ها در محیط نرم افزار
در زمان کشیدن نقشه نیازمند این هستیم که الِمان ها را در جهات مختلف در صفحه قرار دهیم. این کار به 

سه روش قابل اجرا است.
 کلید Tab ؛

 فشار دادن کلید کنترل و حرکت هم زمان موس؛
 تغییر »Variant« در تب »Symbol Data« در پنجرۀ تنظیمات.
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ج( وارد کردن سمبُل‌های اتصال زاویه‌ای
از این سمبُل‌ها برای اتصال الِمان‌های مختلف در نقشه‌کشی استفاده می شود. برای وارد کردن اتصالات از 

محیط »Toolbar« یا از »Insert → Connection Symbol« استفاده می‌کنیم.

د( وارد کردن سمبُل‌ها و تجهیزات
اولین گام برای وارد کردن الِمان‌های مدارهای برق در یک نقشه، وارد کردن سمبُل‌هاست. آنها را با زدن دکمۀ 

»Insert« در کیبورد یا آیکون مربوطه یا مسیر »Insert/Symbol« در نقشه وارد می‌کنیم.

در»ePLAN« ارتباط بین سمبل‌ها به صورت اتوماتیک برقرار می شود. لذا برای افزایش دقت و سرعت، 
حتماً دکمۀ »Snap to grid« را در حالت ON قرار دهید.

بدانید

با استفاده از اتصالات، یک مربع ترسیم و آن به چهار قسمت مساوی          تقسیم کنید. این فعالیت 
را در دو حالت »On« و »Off« بودن دکمۀ »Snap to grid« بررسی کنید.

فعا   لیت
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تفاوت کاربرد سمبل‌های شمارۀ 1 و 2 در شکل قبل چیست؟
فعا   لیت

پس از کلیک بر روی آیکون سمبُل، پنجرۀ زیر باز می شود.

در پنجرۀ فوق، سمبل‌ها را به صورت لیست و درختی می‌توان مشاهده کرد. البته حالت نمایش درختی به 
دلیل دسته بندی سمبل‌ها کاربردی‌تر است. در حالت نمایشِ لیستی با کلیک بر روی هرکدام از سر ستون‌ها 

می‌توان ترتیب نمایش تجهیزات را مثلًا بر اساس شماره یا حروف مرتب سازی کرد.
نقشه کشی در  برای  انتخابی  اوّل، کتابخانۀ  پودمان  یادآوری است که مطابق مطالب گفته شده در  به  لازم 

نرم‌افزار »ePLAN«، می‌تواند استاندارد »IEC« ‌باشد.
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وارد کردن سمبل ها در نقشه
فیلم

پژوهش
در شکل فوق، قسمت »Filter« چه کاربردی دارد؟

1ـ تمام بلوک های زیر شاخۀ »symbol  ـ  IEC« را بررسی نمایید. 
2ـ سعی کنید در حالت نمایش لیستیِ سمبل‌ها، ترتیب نمایش سمبل‌ها را جابه جا کنید.

چگونه می‌توان جهت قرارگیری »Interruption Point« را در صفحۀ نمایش تغییر داد؟

فعا   لیت

فعا   لیت

هـ ( آدرس دهي بين سيم ها و اتصالات بين صفحات
برای آدرس دهي اتصالات بين صفحات مختلف از سمبلي به نام »INTRRUPTION POINTS« استفاده 
می شود. سمبل‌های اشاره شده ادامۀ اتصالات بين صفحات يا چندين بخش از كي صفحۀ شماتیک را مشخص 
مي‌كنند. اين عناصِر زماني مورد استفاده قرار می گیرد كه لازم باشد از پتانسيل خاص يا سيگنال ها در چند 

صفحه استفاده شود. فراخوانی این سمبل از مسیر
»INSERT → CONNECTION SYMBOL → INTRRUPTION POINTS« 	

صورت می‌گیرد. پس از انتخاب »Interruption Point« در زیرِ نشانگرِ موس قرار می‌گیرد.يا آیکون 

پس از رها کردن این الِمان در جهت دلخواه، کادر تنظیمات این سمبل مانند زیر باز خواهد شد.



177

پودمان پنجم: تفسیر نقشه های الکتریکی به کمک رایانه

/ .L 2 9/ .L 3.0
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در پنجرۀ بالا یک نام برای این الِمان در نظر می‌گیریم. این نام می‌تواند سطحی از یک ولتاژ یا یک نام دلخواه 
باشد. همچنین با کلیک بر روی دکمه‌ای که در شکل مشخص شده است، یک پنجره باز خواهد شد. در این 
پنجره تمام »Interruption Point« های قبلی که از آنها در محیط پروژه استفاده شده‌ است، قرار دارند. لذا 

در صورت انتخاب هرکدام از آنها، الِمان فعلی به آن الِمانِ انتخاب شده ارجاع داده می شود.
)CROSS  ـ  REFERENCE( آدرس دهی الِمان ها به هم )و

یکی از مهم‌ترین ابزارها در نقشه‌ خوانی برق، ارجاع اجزای الِمان ها به یکدیگر است. به این عمل »آدرس دهی‌« 
گفته می شود. به جرأت می‌توان گفت که مهم ترین ایده‌ای که باعث شد مهندسان برق به فکر طرّاحی یک 

نرم افزار هوشمند جهت طرّاحی تابلوهای برق باشند، آدرس دهی بین تجهیزات است. 
به طور مثال وقتی بخواهید تیغه‎های قدرت یک کنتاکتور را با بوبین آن در مدار فرمان آدرس دهی )ارجاع( دهید 
یا مثلًا بخواهید یک سیم در یک صفحه را به صفحۀ دیگری منتقل کنید این ابزار به شما کمک خواهد کرد. نوع 
نمایش »Reference  ـ Cross« ها به نوع کادر صفحه )Template( و تنظیمات این الِمان برمی شود. معمولاً در 
نقشه‌های برق برای دسترسی راحت‌ به الِمان‌ها، صفحه به ده ستون موازی تقسیم می شود. به طور مثال در شکل 
زیر منظور از آدرس دهی L /3. 0 یک »Interuption Point« است که به یک »Interuption Point« دیگر در 

ستون صفر از صفحۀ سه، ارجاع داده می شود.

 »Cross ـ    Reference« برای تغییر محل قرارگیری اطلاعات
مربوط به »Interuption Point« از قسمت نشان داده 

شده در شکل روبه رو می توان استفاده نمود.

شماره ستون

 صفحه 2 صفحه 3

شماره صفحهشماره ستونشماره صفحه

L /3. 0 L /2. 9 
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در صورتی که بخواهیم از یک نقطه به چندین محل ارتباط برقرار کنیم، باید در پنجرۀ تنظیمات این تجهیزۀ 
تیکِ »Star Source« را بزنیم. در غیر این صورت آدرس دهی به صورت زنجیر وار است.

اکنون می‌خواهیم مدار قدرت و مدار فرمان »راه‌اندازی موتور به صورت دائم« را رسم نماییم.

ساخت صفحات مربوط به مدار قدرت و مدار فرمان راه‌اندازی موتور به صورت دائم.
فیلم

ترمینال های  از  استفاده  با  را  ورودی  برق  روبه رو  شکل  مانند  ابتدا 
پتانسیلی تأمین می‌کنیم.

پس از آن با استفاده از سمبل‌های اتصال زاویه‌ای باید سیم کشی برق را 
به منظور گرفتن انشعاب‌های مصرفی به نقاط مورد دلخواه هدایت کرد.

R S T N PE
برق ورودی

همان طور که قبلًا اشاره شد، کار با این نرم‌افزار باید مطابق استاندارد »IEC« باشد. لذا برای انتخاب 
الِمان‌های مدار خود، از بانک الِمان‌های مربوط به »Symbol  ـ  IEC« استفاده کنید.

نکته

. اولین الِمان حفاظتی که در مدار وارد خواهد شد، کلید حفاظت موتوری است. هرگاه سخن از مدار فرمان 
است، قطعاً سروکار ما با نقشه‌های گسترده است. لذا از کتابخانۀ سمبل‌ها و از قسمت مربوط به تجهیزات 

نقشه‌های گسترده )Line  ـ  Multi(، کلید حفاظت موتوری مورد نظر را انتخاب خواهیم کرد.
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پس از انتخاب کلید حفاظت موتوری، بلافاصله این الِمان زیر نشانگر موس قرار خواهد گرفت. هر الِمانی که 
لذا  باز خواهد شد.  تنظیمات آن  به  پنجرۀ مربوط  بلافاصله  انتخاب شود،  و تجهیزات  از کتابخانۀ سمبل ها 
با رهاکردن کلید در مکان دلخواه، پنجرۀ تنظیمات آن مطابق شکل زیر باز خواهد شد. لازم به ذکر است 

تنظیمات اکثر الِمان‌ها و اشَکال گرافیکی آنها به صورت شکل زیر است.

همان طور که در شکل مشخص شده، این پنجره دارای چهار تبَ )Tab( است.

تبَ )Tab( اوّل: تنظیم مشخصات الِمان
.)Q1( نام تجهیز در این قسمت وارد می شود 

 شمارۀ پایه‌های تجهیز در این قسمت وارد می شود. علامت پرچم )¶( در »ePLAN«  نشان دهندۀ اینتر 
است، که برای درج آن باید از ترکیب کلیدهای »Ctrl + Enter« استفاده شود.

.)16A, SET=12A( مشخصات فنی در این قسمت وارد می شود 
 درصورتی که پایه‌های تجهیز انتخابی نیاز به توضیح داشته باشند از این قسمت استفاده می شود.



180

تبَ )Tab( دوم: تنظیم مشخصات ظاهری الِمان

برای تنظیم پنجرۀ فوق به جدول زیر توجه کنید.

Font sizeانتخاب اندازۀ فونتRow Spa.فاصلۀ سطرها

Colorتنظیم رنگLanguageانتخاب زبان

Alignmentانتخاب نقطۀ جابه جایی مختصاتیBoldضخیم کردن متن

Angleتنظیم زاویۀ قرارگیریItalicمورّب کردن متن

Layerانتخاب لایه کاریUnderlineکشیدن خط زیر متن

Fontانتخاب نوع فونتX coor.تجهیز در صفحۀ نمایش X مختصات

Invisibleدیدنی و نادیدنی کردن تجهیزY coor.تجهیز در صفحۀ نمایش Y مختصات
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تبَ )Tab( سوم: تنظیم مشخصات ظاهری الِمان

تبَ )Tab( چهارم: اختصاص مشخصات پایه‌ای به هر سمبل
تمام تجهیراتی که از منوی سمبل انتخاب می‌شوند تصاویری ظاهری هستند و هیچ گونه اطلاعاتی از قبیل کد سفارش 
قطعه، کارخانه سازنده و...، قابل استفاده جهت گزارش‌گیری به صورت هوشمند، ندارند. لذا برای تحقق این امر در 
قسمت »Part« و با کلیک بر روی دکمۀ نشان داده شده در شکل زیر و ورود به بانک اطلاعاتی »ePLAN« به مسیر 

»Engeenering → Component   ـ  Part → Electrical« و به سمبل هویت می بخشیم.

این اطلاعات پایه‌ای برای تعداد محدودی از تجهیزات در »Part Management« نرم‌افزار »ePLAN« وجود 
دارد.

شرکت پژوهش تجهیزات  به  مربوط   »Data Base« می‌توان  چگونه  کنید  تحقیق  اینترنت  در  با جست و جو 
»ETI« به اطلاعات پایه‌ای نرم افزار »ePLAN« اضافه کرد؟
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قدرت  تیغه‌های  موتوری  حفاظت  کلید  از  بعد 
کنتاکتور را از مسیر نشان داده شده در شکل مقابل 
به  مربوط  تنظیمات  کلید  مشابه  و  می‌کنیم  وارد 

کنتاکتور را نیز وارد می‌کنیم.

حال نوبت اضافه کردن موتور است. موتور را هم از کتابخانۀ سمبل‌ها و مسیر زیر انتخاب می‌کنیم:
Insert/IEC _ Symbol/Electrical _  Eng./Power _ Consumer/M31ـ

پارت،  قسمت  از  و  کنید  اجرا  برنامۀ خود  در  زیر،  مدار  مشابه شکل  را،  کنتاکتور  و  موتور  تنظیمات 
اطلاعات پایه‌ای و متناسب با هر تجهیز را از کتابخانۀ موجود در »ePLAN« انجام دهید.

فعا   لیت

R S T N PE
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ز( وارد کردن ترمینال‌ها
برای وارد کردن ترمینال‌ها پس از زدن دکمۀ »Insert« می توان به کتابخانۀ »Symbol ـ IEC« وارد شد و 

از زیر شاخۀ »Terminals and Plugs« نیز می توان انواع ترمینال‌ها را وارد کرد.

در »ePLAN« بعضی الِمان‌ها مثل تیغه‌‎های کنتاکتور یا ترمینال‌ها اگر در یک ردیف باشند فقط اولین 
مورد را نام گذاری کنید. سپس در زمان وارد کردن بقیۀ الِمان‌ها قسمت »Displayed DT« در پنجرۀ 
تنظیمات خالی بگذارید. در این حالت مشاهده خواهید کرد که در قسمت »Full DT« نام آن تجهیز 

مشابه تجهیز قبلی و هم راستا با خودش خواهد شد.

نکته

در زمان وارد کردن یک ردیف ترمینال، در صورتی که در یک راستا قرار داشته باشند، فقط نام اولین ترمینال 
را وارد کنید زیرا با توجه به نکتۀ ذکر شدۀ قبلی، به تایپ دوبارۀ نام هرکدام از ترمینال‌ها نیاز نیست.
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ح( وارد کردن خطوط کابل
وارد کردن کابل به این شکل است که پس از اینکه ترمینال‌های خروجی تابلو مشخص شدند باید توسط 
الِمانی که معرفی می شود، خطوط کشیده شده بین دو سمبل را به صورت افقی قطع کند. برای وارد کردن 
کابل از قسمت »Insert/Cable Definiation« یا آیکون          خط مشخصۀ کابل را در زیر نشانگر موس 
پنجرۀ  لحظه،  این  در  می گذرانیم.  اتصالات  روی  از  افقی  به صورت  را  آن  کلیک  بار  دو  با  و  می دهیم  قرار 

تنظیمات کابل باز می شود. در این صورت، مانند شکل زیر، اطلاعات آن را کامل می‌کنیم.

زیر  تصویر  مشابه  را  دائم«  »راه‌اندازی  فرمان  مدار  موتور،  برای یک  و  کنید  ایجاد  یک صفحۀ جدید 
طرّاحی کنید.

فعا   لیت

وارد کردن برچسب کابل در نقشه و انجام تنظیمات مربوطه
فیلم
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ط( شماره گذاری اتوماتیک ترمینال‌ها، تجهیزات
، که در منوی »Tollbars« هستند، شماره‌گذاری اتوماتیک را با استفاده از آیکون‌های 

انجام خواهیم داد.

ی( شماره‌گذاری ترمینال‌ها
فعال شود. سپس با کلیک بر روی این آیکون، ابتدا بر روی یکی از ترمینال‌ها کلیک می کنیم تا آیکون 

پنجرۀ زیر باز خواهد شد:

در این پنجره، همان طور که در شکل فوق مشخص است، قسمت شمارۀ 1 را انتخاب می کنیم تا همان گروه 
ترمینالی که انتخاب کرده‌ایم شماره گذاری شود یا اینکه تمام گروه‌های ترمینال موجود در نقشه شماره گذاری 
شود. در قسمت شمارۀ 2 مشخص می‌کنیم که شروع شماره گذاری با چه شماره‌ای انجام شود. در قسمت سوم 

هم پله‌های افزایشی شماره گذاری را مشخص می‌کنیم. در پایان OK را کلیک خواهیم کرد.

پژوهش
سایر گزینه‌های پنجرۀ »Numbering Terminal« چه وظیفه‌ای بر عهده دارند.

ک( شماره‌گذاری تجهیزات
فعال شود. سپس با کلیک بر روی این آیکون، ابتدا بر روی یکی از تجهیزات کلیک کنید تا آیکون 

پنجرۀ زیر باز خواهد شد. تمام تنظیمات را مطابق تصویر زیر انجام دهید و بر روی OK کلیک نمایید.
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پژوهش
در پنجرۀ فوق سایر پارامترهای قسمت »Format« را بررسی و انتخاب و نتیجۀ حاصل را گزارش کنید.

ل( شماره‌گذاری اتوماتیک صفحات
چنانچه در پروژه به صفحات بیشتری نیاز باشد، لازم است زیرمجموعۀ پروژۀ صفحات را ایجاد و هر صفحه را، 

به ترتیب نقشه ها، رسم کنیم. سپس جهت شماره گذاری اتوماتیک به صورت زیر عمل می کنیم.

مدار قدرت و فرمان کنترل دو موتور به صورت »یکی پس از دیگری« را با توجه به تمام تنظیمات فوق 
طرّاحی کنید.

فعا   لیت
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با راست کلیک کردن بر روی صفحات انتخاب شده یا با انتخاب گزینۀ »Number« از منوی »Page«، پنجرۀ 
زیر باز می شود.

در تصویر فوق و در قسمت شمارۀ یک، شمارۀ اولین صفحه و در قسمت دوم پله‌های افزایشی، شمارۀ صفحات 
را تنظیم و سپس بر روی OK کلیک کنید.

نحوۀ شماره گذاری اتوماتیک صفحات و تجهیزات
فیلم

م( تهیۀ گزارش
پس از کشیدن نقشه‌های شماتیک، می‌توان از الِمان‌هایی که مشخصات پایه‌ای آنها کامل شده است گزارش 
تهیه کرد. مسیر فراخوانی گزارش‌گیری از منوی »Utilities → Reports → Generate« انجام می‌گیرد. 
پس از کلیک بر روی کلمۀ »Generate« پنجره به شکل زیر باز خواهد شد. در این پنجره برای تهیۀ گزارش 

جدید باید روی »New« کلیک نمایید.
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پس از کلیک کردن »New«، پنجرۀ روبه رو باز خواهد 
خروجی  گزارش‌های  از  لیستی  پنجره،  این  در  شد. 
باز  کادر  در  کار  این  برای  است.  مشاهده  قابل  نرم‌افزار 
 OK و سپس بر روی »Part List« شده، ابتدا بر روی

کلیک می‌کنیم.
یا  الِمان‌ها  فیلتر کردن  جهت  پنجره‌ای  بعد،  مرحلۀ  در 
مکانی که از الِمان‌ها استفاده شده است، ظاهر می شود. اگر 
قصد فیلتر کردن ندارید، بدون زدن تیک‌های مربوطه، بر 
روی OK کلیک کنید تا پنجرۀ تنظیمات مربوط به شمارۀ 
صفحۀ جدیدی که می‌خواهد ایجاد شود، باز شود. در این 
مرحله، مطابق تصویر زیر، شمارۀ صفحه و همچنین مکانی 
را که می‌خواهیم صفحۀ جدید در آن قرار گیرد، مطابق 

شماره‌های 1 تا 4 تنظیم و OK را کلیک می‌کنیم.
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 »Close« اگر قصد تهیۀ گزارش دیگری ندارید، مطابق مرحلۀ 5 تصویر فوق، بر روی OK با کلیک بر روی
کلیک کنید تا بر روی صفحه جدید ایجاد شده دبل کلیک کنید تا »Part List« جدیدِ ایجاد شده را ملاحظه 

کنید.

مدار راه اندازی یک موتور به صورت »چپ گرد ـ راست گرد سریع« را به صورتی که مدار قدرت در یک 
صفحه و مدار فرمان در صفحۀ دیگر باشد، با تمام تنظیمات، ترسیم و گزارش مربوط به تجهیزات و 

کابل ها را تهیه کنید.

فعا   لیت

اگر بعد از تهیۀ گزارش‌های مورد نیاز، در برنامه تغییراتی اعمال کنیم که باعث شود تجهیزات، کابل‌ها و سایر 
مواردی که به گزارش تهیه شده وابسته‌اند تغییر کنند، می‌توان تمام گزارش‌ها را به روز رسانی کرد. برای این 

کار دو راه وجود دارد:
 صفحۀ گزارش مربوطه را باز کنیم و سپس از مسیر »Utilities / Reports / Update« فایل‌ها به روزرسانی 

شود.
 تمام صفحات مربوط به گزارش‌ها را انتخاب کنیم و از مسیر »Utilities / Reports / Update« فایل‌ها به 

روزرسانی شود.

ن( چاپ نقشه
 »Ctrl + P« یا با کلیدهای ترکیبی »Project/Printer« چاپ نقشه توسط پرینتر: چاپ نقشه‌ها از مسیر 

صورت می‌گیرد.

0
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از مسیر »Page/Export« صورت  فایل‌ها  PDF: ذخیره‌سازی  به صورت فایل  ذخیره سازی نقشه‌ها   
می‌گیرد. در این حالت پنجره‌ای به شکل زیر باز خواهد شد:

 OK تنظیمات این پنجره را مطابق توضیحات داده شده در شکل فوق، انجام دهید و در نهایت بر روی دکمۀ
کلیک نمایید. فایل »PDF« ایجاد شده دارای »Interruption Points«ها و »Cross-Reference« های 
 »Interruption« هوشمند است. به این صورت که با کلیک بر روی هر کدام از نقاط ذکر شده، صفحۀ مربوط به

یا »Cross-Reference« لینک می شود و با همان نقطه باز خواهد شد.

در این قسمت نام فایل را مشخص می کنیم
محل ذخیره سازی فایل

چاپ نقشه به صورت رنگی
چاپ نقشه به صورت سیاه و سفید

چاپ نقشه به صورت خاکستری

نحوۀ گزارش گیری از تابلوی طراحی شده
فیلم
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با دقت به مراحل ساخت یک سمبُل توجه کنید.
فیلم

»ePLAN« ساخت سمبل در
در نرم‌افزار »ePLAN«، علاوه بر کتابخانۀ پیش فرض نرم‌افزار، امکان ساخت و اضافه کردن سمبُل‌های جدید 

نیز وجود دارد. برای این کار از مسیر زیر، یا از طریق منوی نوار ابزار بر روی آیکون 
کلیک می‌نماییم.

Utility → Mastaer Data → Symbol → New 	
سپس مشاهده می شود که پنجرۀ جدیدی باز خواهد شد. در این پنجره باید مشخصات سمبُل مورد نظر را 

مطابق تصویر زیر وارد کرد.

پس از وارد کردن مشخصات تجهیز مورد نظر، بر روی OK کلیک می کنیم تا صفحۀ اصلی جهت ساخت 
سمبُل باز شود. در پنجرۀ باز شده، با استفاده از الِمان‌های گرافیکی، به ساخت سمبُل می پردازیم. پس از 
 ،»Symbol Editor« و آیکون‌های »Toolbars« مشخص شدن پایه‌های ورودی و خروجی، با استفاده از نوار

مطابق تصویر زیر و با توجه به جهت پایه‌ها، آنها را جهت استفاده در برنامه، هوشمند و فعال خواهیم کرد.
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با توجه به توضیحات فوق، یک سمبُل درایو بسازید و مطابق نقشۀ زیر، از آن به منظور راه‌اندازی یک 
موتور استفاده کنید.

فعا   لیت

I>I>I>

A20

1

1 1 1

11

2

2 2 2

13

14

3

4

5

5

ASET= 16

QI−

K2

U1 V1 W1 PE

PE

UT2 VT2 WT2 PE

−

K2−

K1−PB3

PB4

M2−

H2−

M
3

2/3

KW7.5

D2−
KW

RE
SE

T

RU
N/

FW
DRESET

GND M5 M4 M3 M2 M1 M0

R11Drive

+10V

1: 15V
2: GND
3: SG-
4: SG+
5: Reserved
6: Reserved

A/I ACI7.5

A1

A2

26/ N

11

1 2

12

Q2−

EM2−

11

12

11

12

13

14

13

14

2/31 2
2/31 2
2/613 2

»ePLAN« در »PLC«

برنامه  نویسندگان  برق،  تابلوهای  و  صنعتی  مراکز  در  هوشمند  کنترل  سیستم‌های  از  گسترده  استفادۀ 
»ePLAN« را بر آن داشت تا طرّاحی این سیستم‌ها را در نرم‌افزار خود قرار دهند. عملکرد موفق نرم‌افزار 
»ePLAN«، سازندگان مطرح و پیشرو از قبیل »SCHEINDER ،ABB ،SIEMENS« را بر آن داشت که 
اطلاعات پایه‌ای محصولات خود را در این نرم افزار، منطبق و سازگار با ساختار آن و به صورت »Macro« هایی 

آماده و قابل استفاده قرار دهند.

»PLC« الف( وارد کردن
برای وارد کردن »PLC« و تجهیزات مربوطۀ مورد استفاده، 
کلیدهای  )یا   »Insert → Symbol Macro« مسیر  از 
ترکیبی Ctrl + Insert( پنجرۀ »Select Macro« را باز و 
»Macro« ی دلخواه را انتخاب می کنیم. در صورت نبودن 
 »Delta« برند  تجهیزات  مانند  نظر،  مورد  »Macro« ی 
 »PLC« ،مطابق شکل زیر »Insert« لازم است از منوی

و تجهیزات مربوطه را در نقشه‌ها وارد کنیم.
هر کدام از تجهیزات سیستم »PLC« باید در یک باکس 
قرار گیرد. لذا ابتدا با کلیک بر روی آیکون           یک باکس 
ترسیم می کنیم و سپس تنظیمات باکس را انجام می دهیم.
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با توجه به پودمان سوم، هر سیستم کنترل »PLC« دارای تجهیزاتی است، که در ادامه، مراحل ترسیم آنها 
را بررسی می نماییم.

ب( ترسیم منبع تغذیه
و  اضافه می کنیم  را  نظر  مورد  ترمینال های   »PLC power supply« از طریق باکس،  ایجاد یک  از  پس 

تنظیمات مربوطه را انجام می دهیم.

)HMI( ترسیم مانیتورینگ )ج
سیستم مانیتورینگ در نقشه کشی فقط به صورت یک باکس است که نوع درگاه ارتباط با »PLC« یا تجهیزات 

دیگر و همچنین ترمینال های تغذیۀ »HMI« را نشان می دهد.

پس از ایجاد یک پروژۀ جدید، یک منبع تغذیه 
ترسیم  خود  سیستم  برای  آمپر،   2/5 ولتِ   24
کنید و کلیۀ تنظیمات آن را انجام دهید. )مطابق 

تصویر روبه رو(

فعا   لیت

Power
Supply

24/DC 2424 00
2.5 NL

L-IN N-IN

1

PE

PE

24 0

1

PE

PE PE

MCB1−

HMI−Power
Supply

24 DC 24 02424 00

1 2 3 4 5

_

+

2.5
NL

L-IN N-IN

6 7 8 9

2 4

1 3

−

»CPU« د( ترسیم
مشابه منبع تغذیه و »HMI« یک باکس برای »CPU« وارد می کنیم و تغذیه و درگاه‌های ارتباطی آن را با 

سایر تجهیزات نشان می‌دهیم.
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نقشۀ زیر را ترسیم کنید و تنظیمات مورد نیاز را انجام دهید.

در تصویر فوق دلیل استفاده از »Interuption Point« های 24، 0 و PE چیست؟

فعا   لیت

بحث

 ـ( ترسیم کارت های ورودی/خروجی ه
با توجه به مطالب مطرح شده در پودمان سوم، سیگنال‌ها دو دسته‌اند:

 دیجیتال )ورودی ـ خروجی(
 آنالوگ )ورودی ـ خروجی(

24 0

1

PE

PE PE

PE

MCB2

DVP10SX11R

2 4

1 3

−MCB1−

CPU−HMI−Power
Supply

24/DC 24

24

0

0

2424 00

1 2 3 4 5

_

+

2.5 NL

L-IN N-IN

6 7 8 9

2 4

1 3

−

24 0

PE PE PE

این سیگنال‌ها در »ePLAN« با استفاده از چهارآیکون
               در نقشه‌ها وارد می‌شوند.

ابتدا  خروجی،  و  ورودی  سیگنال‌های  وارد کردن  از  قبل 
نقشۀ مدار راه‌انداز موتور را بررسی می کنیم و مطابق تصویر 
مقابل، با ایجاد تغییراتی در مدار فرمان آن، امکان راه‌اندازی 
موتور از طریق سیستم »PLC« را برقرار خواهیم کرد. برای 
فرمان،  مدار  در  سوئیچ  سلکتور  یک  دادن  قرار  با  کار  این 
کنترل موتور را بین دو حالت »Manual« و »PLC« تغییر 

می‌دهیم.
در »ePLAN« می‌توان به تعداد نامحدود از یک تجهیز در 
 »Cross ـ  reference« نقشه‌ها استفاده کرد و با استفاده از
به  توجه  با  پیدا کرد.  را در صفحات مختلف  آنها  جانمایی 
اینکه »CPU« در این پروژه کامپکت و از برند دلتاست، لذا 
برای نشان دادن سیگنال‌های ورودی و خروجی باید مجدداً 
»PLC BOX« را با نام »CPU« در صفحۀ شماتیک وارد 

کرد.
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مدار فرمان کنترل دو موتور به صورت مجزا از هم را به صورت دستی و کنترل با »PLC« ترسیم کنید. 
سپس ورودی های دیجیتال مورد نیاز »PLC« را ترسیم نمایید.

فعا   لیت

MOTOR RUNCOM EMERGENCY STOP RESEVE RESEVE

MCB2

14 14

13

24

0

21 3

13

−

CPU−

4 5

K1

X0S/S X1 X2 X3

− EM1−

بنابراین ابتدا یک باکس در نقشه ایجاد می کنیم و با استفاده از آیکون مربوط به ترمینال های ورودی‌ دیجیتال          ، 
چهار عدد ترمینال دیجیتال در این باکس قرار می دهیم. مطابق تصویر زیر سیگنال‌های ورودی را به سیستم 

کنترل معرفی می کنیم.

 »Text« همان طور که در شکل فوق مشخص شده است، توضیحات مربوط به هر سیگنال، با استفاده از یک
در زیر ترمینال ورودی همان سیگنال نوشته می شود.

برای وارد کردن تیغه‌های کمکی حالت باز یا بسته، با فشار دادن کلید »Insert« و از مسیر  	
«IEC ـ Symbol / Electrical Engineering / Coil  ـ Contact ...«

اقدام کنید. همچنین تنظیمات مربوط به تمام الِمان‌های وارد شده را در پنجره‌ای که پس از رها کردن 
انجام دهید. همچنین  باز خواهد شد،  الِمان  با دبل کلیک بر روی آن  یا  الِمان در صفحۀ نمایش  هر 
از  الِمان در جای دیگری  این  بیانگر این است که  الِمان‌ها  »reference  ـ  Cross« ذکر شده در کنار 

نقشه‌ها هم به کار رفته است.

بدانید

ترمینال های خروجی را در باکس قبل اضافه می کنیم. بر اساس نقشه‌های مدار فرمان و مدار قدرت شکل 
قبل، یک سیگنال خروجی جهت راه‌اندازی نیاز داریم. خروجی دوم را هم با یک لامپ سیگنال )جهت نشان 

دادن وضعیت کارکرد موتور( نشان خواهیم داد.
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با توجه به اینکه »PLC« کامپکت است، باید ترمینال های ورودی در شکل زیر نشان داده شود.

CO
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COMCOM

CPU
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/4.0

Lamp_SignalMOTOR RUN_CMD

9

Y1C1Y0

10

MOTOR RUN-CMD
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COM COM Lamp - Signal

CPU−

/24

7 9
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/0

8 0

C0 C1

R1
A1

A2

X1

X224VDC
− H1−

4.4

4.4

/4.0
/3.5

/2.61413

/5.4

اکنون برای اتصال ترمینال های خروجی »PLC« به رله و لامپ سیگنال از مسیر زیر، یک بوبین برای رله در 
نقشه وارد می کنیم و تنظیمات مورد نیاز را مطابق مراحل زیر انجام می دهیم.

«Inser → IEC ـ Symbol → Coil» 	

چراغ سیگنال را هم در زیر ورودی دوم قرار می دهیم و نقشه را مطابق شکل زیر ترسیم می کنیم.
با توجه به اینکه »PLC« کامپکت است، باید ترمینال های ورودی در شکل زیر نشان داده شود.



197

پودمان پنجم: تفسیر نقشه های الکتریکی به کمک رایانه

و( ساخت ماکروها
در صورتی که »PLC« های مورد نظر دارای کتابخانه‌های آماده نباشند باید با استفاده از »PLC BOX« و 
ترمینال‌های ورودی و خروجی، سیستم کنترل مورد نظر را طرّاحی کرد. در عین حال و با استفاده از منوی 
»Macro ـ Create« می‌توان کتابخانه‌ای از »PLC« هایی که با روش دستی ساخته شده‌اند تهیه کرد تا در 

طرّاحی های بعدی بتوان به راحتی از آنها استفاده نمود.
هم  کنار  در  می‌خواهند  که  سمبل‌هایی  از  مجموعه‌ای  باید  ابتدا  کار،  این  برای 
منوی از  سپس  شود.  گرفته  موس  توسط  باشند،  داشته  را  ماکرو  یک  نقش 

تبدیل خواهند  ماکرو  به یک  آنها   B میانبر  کلید  فشردن  با  یا   »Edit → Create _ Symbol _ Macro«
شد. برای مثال اگر بخواهیم مجموعۀ 
ماکرو  به  را  دیجیتال  ورودی های 
را  مجموعه  این  ابتدا  کنیم،  تبدیل 
 B کلید  سپس  و  می کنیم  انتخاب 
مرحله  این  از  پس  می دهیم.  فشار  را 
خواهد  باز  روبه رو  شکل  به  پنجره‌ای 

شد.
در قسمت اوّل، محل ذخیرۀ فایل و در 

قسمت دوم نام ماکرو را می‌نویسیم.
برای فراخوانی و استفاده از ماکروهای 
 Insert →« منوی  از  شده  ساخته 
کلیدهای  از  یا   »Symbol Macro
استفاده   »Ctrl  +  Insert« ترکیبی 

می‌کنیم.

فعالیت کارگاهی قبل را با ترسیم ترمینال های خروجی و تنظیمات مربوطه تکمیل کنید.
فعا   لیت

ePLAN وارد کردن تجهیزات سیستم کنترل در نرم افزار
فیلم
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با استفاده از قابلیت »Create Macro« ماکروهای مربوط به منبع تغذیه، »CPU« ،»HMI« ورودی 
و خروجی‌های دیجیتال و آنالوگ و »PLC« دلتا را بسازید.

فعا   لیت

در نرم‌افزار »ePLAN« می‌توانید نقشۀ سه بعدی تابلوهای برق را طرّاحی کنید.

انتخاب، لیست  ارائه شده در پنوماتیک از نظر  با توجه به مطالب  برنامۀ کنترل خط زیر را بنویسید. 
شیرها و جک ها را بررسی کنید و سیستم کنترل مربوط را برای یک ایستگاه یا دو ایستگاه طرّاحی 

کنید. 
لازم به ذکر است موتور 1 باید قابلیت کنترل دور داشته باشد.

بدانید

پروژه

m1
M2

1ـ تفکیک کارتن باز 
با بسته

2ـ پر کن بسته

جک 2

جک 1

حسگر خازنی
حسگر القایی حسگر نوری

جک 3
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ارزشیابی پایان شایستگی

شرح کار
تعیین تعداد I/O ، سیم کشی و اجرای کامل پروسه و برنامه ریزی کنترل فرایند، با رعایت کامل نکات ایمنی و همراه با         

راه اندازی نهایی پروسه 

استاندارد عملکرد:
استاندارد عملکرد: پس از اتمام واحد یادگیری و کسب شایستگی در نرم‌افزار »ePLAN«، هنرجویان قادر خواهند بود تا 

نقشه‌های مربوط به تابلوی برق و سیستم کنترل یک پروسه صنعتی را بکشند.
شاخص ها:

ساخت یک پروژه جدید، رسم دیاگرام تک خطی، نوشتن لاجیک کنترلی مدار فرمان، کشیدن نقشه‌های گسترده، استفاده از 
شماره گذاری اتوماتیک، گرفتن گزارش های خروجی مورد نیاز

شرایط انجام دادن کار و ابزار و تجهیزات:
الف( شرایط

20°C ± 3 1ـ اجرا در سایت رایانه 2ـ نور یکنواخت با شدت 450 لوکس 3ـ تهویۀ استاندارد و دمای
4ـ ابزار آلات و تجهیزات استاندارد و آماده به کار 5  ـ وسایل ایمنی استاندارد 6  ـ زمان 180 دقیقه

ب( ابزار و تجهیزات
1ـ رایانه دارای نرم‌افزار »ePLAN«     2ـ چاپگر       3ـ میز کار

معیار شایستگی:
نمرۀ هنرجوحداقل نمرۀ قبولی از 3مرحلۀ کارردیف

1انجام تنظیمات مربوط به تجهیزات1
1ایجاد صفحات جدید2
3»Interruption Point « 2صحت استفاده از
3رسم دیاگرام تک خطی4
3رسم دیاگرام سه خطی5
3استخراج گزارش خروجی6

و  بهداشت، توجهات زیست محیطی  ایمنی،  شایستگی های غیرفنی، 
نگرش:

1 قواعد و اصول در مراحل کار؛
2 استفاده از لباسکار و کفش ایمنی؛

3 تمیزکردن گیره و محیط کار؛
4 رعایت دقت و نظم.

2

*میانگین نمرات
* حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، »2« است.

		
		

رسم دیاگرام 
تک خطی

رسم مدار 
فرمان

گرفتن گزارش های 
Cable List و
Part List 

ذخیره سازی 
نقشه ها به صورت
 فایل الکترونیک

انجام دادن 
محاسبات مورد نیاز

رسم دیاگرام سه 
خطی مدار فرضی
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سازمان پژوهش و برنامه ریزی آموزشی جهت ایفای نقش خطیر خود در اجرای سند تحول بنیادین 
در آموزش و پرورش و برنامه درسی ملی جمهوری اسلامی ایران، مشارکت معلمان را به عنوان یک 
سیاست اجرایی مهم دنبال می کند. برای تحقق این امر در اقدامی نوآورانه سامانه تعاملی برخط 
اعتبارسنجی کتاب های درسی راه اندازی شد تا با دریافت نظرات معلمان دربارۀ کتاب های درسی 
به دانش آموزان و معلمان  با کمترین اشکال  اولین سال چاپ،  را در  نونگاشت، کتاب های درسی 
ارجمند تقدیم نماید. در انجام مطلوب این فرایند، همکاران گروه تحلیل محتوای آموزشی و پرورشی 
استان ها، گروه های آموزشی و دبیرخانۀ راهبری دروس نقش سازنده ای را بر عهده داشتند. ضمن 
ارج نهادن به تلاش تمامی این همکاران، اسامی هنرآموزان و خبرگان بازار کار که تلاش مضاعفی 
را در این زمینه داشته و با ارائۀ نظرات خود سازمان را در بهبود محتوای این کتاب یاری کرده اند 

به شرح زیر اعلام می شود.
عباس  آقاجانی،  بارده، مجتبی  رضا حیدرپور  نجف آبادی،  ایمانیان  علی  رفعتی،  احسان  اصفهان: 
منظری، محمدمهدی علی بابا، فرزاد اعظم، مهدی کاظمی، سعید هادی، محمد ابراهیمی، محمدرضا 

پایا، سید اکبر زهرایی، سید فرهاد مدرسی، سید رحیم زرافشان، علی رضا نباتی
قزوین: گل دوست لیاولی، مهدی ناصرلویی، محمدرضا آقایی، محمدجواد حسنا، فرهاد مشاط زادگان

مرکزی: حمید شفیع نیا، علی پورشجاع، حامد کوچکی، ابوالفضل حسنی
خوزستان: آرش قنواتی، بهزاد بهزادی مقدم، امین نقاش، امین برملا

تهران: یاسر پازوکی، محمدحسن خاجی، محمد چشفر، مهدی اسماعیلی
تبریز: یونس غفارزاده خسروشاهی، عباس رسولی، محمد شعوری میلانی، اسماعیل مصطفی زاده، 

ابراهیم شایان فر
قم: محمد قاسمی ورزنه، مسعود محمدی، محمد علیمرادی، کاظم بهرامی

خدابنده،  میلاد  نیارکی،  جلوخانی  محمدرضا  یعقوب لو،  مجتبی  سپهرآذر،  رسول  فنی:  خبرگان 
مرتضی زارعی، مرتضی قدمی، مهرداد دقاق، محمدرضا راد، عبدالرضا سامع، محمد ارشدی، ابوالفضل 

طالبیان، نوید خوش خو
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